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2. MARCO TEORICO Y CONCEPTUALES.

2.1 Girdscopo

Un giréscopo es un artefacto que gira rapidamente sobre un eje libre que se mantiene en una
direccion constante. Se utiliza en la estabilizacién de barcos y aviones.

Por ejemplo Podemos decir que el giréscopo es el piloto automatico que nos va a mantener el
rumbo 6 direccién del helicéptero de una manera totalmente controlada. Dada la constante
evolucién que a través de los afios han experimentado y segun la tecnologia empleada, vamos a
clasificarlos en dos grandes grupos:

A) Convencionales: - Mecanicos -Piezoeléctricos - Con bloqueo de la cabeza:
B) Efecto " heading hold (también piezoeléctricos).

La diferencia fundamental entre los convencionales y los de bloqueo de la cabeza, consiste en que
ante una misma perturbacién producida por un agente exterior, como podia ser un golpe de
viento, la reaccion entre ambos sera diferente y aunque los dos trataran de corregir el rumbo
alterado por dicho golpe de viento , los primeros lo haran transcurrido un tiempo, tiempo que
aunque minimo sera el causante de lograr un rumbo diferente al inicial cuando la estabilidad se
consiga, mientras que los segundos, "recuerdan siempre" la posicion inicial que se tenia antes de
la perturbacidn y alli dirigen la cabeza del helicoptero una vez pasada la misma.

Para entender mejor el efecto "heading hold", podemos imaginar que el giréscopo transforma al
helicoptero en una auténtica brujula magnética, con la Unica diferencia que en una brajula real ,la
aguja sefiala siempre al invariable Polo Norte magnético de la Tierra y en cambio nuestro
giréscopo, sefialara la direccion que el helicéptero tenga en el momento de conectar la emisora ;
de ahi la importancia de no moverlo en los primeros segundos de conexién, momento que
necesitan los circuitos electrénicos del girdscopo, para memorizar la posicidon del hipotético Polo
Norte.

La rigidez en el espacio de un giréscopo es consecuencia de la primera ley del movimiento de
Newton, que afirma que un cuerpo tiende a continuar en su estado de reposo o movimiento
uniforme si no estd sometido a fuerzas externas. Asi, el volante de un girdscopo, una vez que
empieza a girar, tiende a seguir rotando en el mismo plano en torno al mismo eje espacial.
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Los girdscopos constituyen una parte importante de los sistemas de navegacion automatica o

guiado inercial en aviones, naves espaciales, misiles teledirigidos, cohetes, barcos y submarinos.
Los instrumentos de guiado inercial de esos sistemas incluyen giréscopos y acelerémetros que
calculan de forma continua la velocidad y direcciéon exactas del vehiculo en movimiento. Estas
sefiales son suministradas a una computadora, que registra las desviaciones de la trayectoria y las
compensa.

2.2 Encoder

El encoder es un transductor rotativo que transforma un movimiento angular en una serie de
impulsos digitales. Se basa en la rotacién de un disco graduado con un reticulo radial formado por
espacios opacos, alternados con espacios transparentes. Un sistema éptico de emisor receptor
infrarrojo detecta el cambio en la superficie del disco, generando dos sefales de cuadratura
(desfasadas 90°), las sefales se identifican como Ay B.

canal 4
canal B

Codigo del disco
Figura 5 Encoder.

El encoder codifica la informacién del desplazamiento y su direccién, normalmente el minimo
desplazamiento es de codificado a partir de un ciclo completo de un ciclo completo de la seial A o
B. observando detalladamente la sefial de cuadratura se puede apreciar que hay informacién del
desplazamiento en cada flanco de las sefiales A o B. observando detalladamente la seiial de
cuadratura se puede apreciar que hay informacién del desplazamiento en cada flanco de las
sefiales Ay B, por lo que es posible decodificar la informacién del desplazamiento y la direccidn.

Incrementar la resolucidn de un encoder permite mayor precision con el mismo dispositivo.

En las sefiales A y B en cuadratura se encuentra codificada la informacion correspondiente al
avance y su direccidn, la cual puede ser en sentido de la manecillas del reloj (Clockwise CW) o en
sentido contrario (CounterClockWise CCW).
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Figura 6 Sefiales de cuadratura

La informacion correspondiente al desplazamiento se obtiene directamente de A o B, un ciclo de la
sefial correspondiente al minimo avance, se puede usar como referencia el flanco de subida o de
bajada: para nuestro encoder que es de 4096 pulsos por revolucidon, el minimo avance
corresponde a 360°/4096=0.087°. Para determinar la direccién del desplazamiento se requieren
ambas sefales; se tiene un circuito mediante el cual se determinan ambas sefiales.

Se implementa un Flip Flop tipo “D”, la sefal A se emplea como dato y B como sefal de reloj, en
sentido CW (lzquierda -derecha) se captura siempre un nivel alto de A. Para el sentido CCW
(Derecha-lzquierda) el flanco de subida B coincide con el nivel bajo de A.

Figura 7 Sefiales del encoder del SRV-02.

3.-DESARROLLO DEL PROCESO

3.1 Giréscopo (GYRO/ STABILIZED PLATAFORM)

El del giréscopo ocupado consta de los siguientes componentes:
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1. Placa base.

Placa Soporte.

3. Moddulo del Girdscopo:
A) Motor de DC.
B) Disco de Inercia.
C) Resortes
D) Sensory Engranes.

Momento Meodulo Gyro
Angular T
e Senso(no
Eje L =7 mostrade)
sensible  motor |
Conectores i A
_ " Resortes
s, I (no visibles)
~, fl
).
% :sr'v-OE'| =i
Soporte o d I J_'_ o
iyt
EEEIEE R Base

Figura 8 Mddulo del giréscopo colocado sobre el servo SRV02

(Plataforma referenciada hacia una mesa o base cualquiera)

El experimento consiste en disefiar un control que mantenga una posicion, mientras se rota el
soporte de la base. Esto representa el problema de colocar un radar en una nave, donde se desea
mantener la direccidn de la luz en el radar independientemente de la pérdida del mantenimiento

de curso de la nave debido a perturbaciones.

3.2 Modelo del médulo SRV-02

Conociendo modelo basico de funcionamiento de un giréscopo:

; sensor
( L 5= ¢ N (-H}
EJe, o F A

sensible

Eje de enfrada

Figura 9 Modelo de un giréscopo
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Considerando que el disco gira con una velocidad constante relativa w,. Cuando la base gira a una

velocidad de w, se obtiene una fuerza de giro, referenciada al eje sensitivo, dada por:
Ty = WyH
Donde H es el momento angular del volante que esta dado por:
H =JsWy
Los resortes montados en el giréscopo se oponen a la fuerza de giro y esta dado por:
TS = KRa
Ty =T,
Donde K, es la tensidn que ejercen los resortes.

Asi el angulo de inclinacion a de con respecto al eje de giro estd en funcién de W, , que estad dada
por la funcion:
B Wyhg

a= (rad)
Ky

La ganancia del giro esta dada por:

Wp
Gy =—
a

c - Kr °/s
9 = H \°de inclinacién

Asi la inclinacion al eje sensible del giréscopo es directamente proporcional a la velocidad a la
velocidad de rotacidn de la base. (Solamente en el espacio de estados. Notese que se ignora la

. . . . . .. (s
dindmica en el eje sensible, un modelo mds completo incluye la dindmica ML(S)) = H(s) ), lo cual
b

quiere decir que el angulo de inclinacion a puede ser usado para medir la rotacion de la
plataforma con relacion a la base sin una medicién directa.

sensor
T (H)
Eje

sensible

Eje de enfrada

Figura 10 Modelo simplificado del giréscopo
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El angulo de inclinacién a esta medido a través de un potenciometro que es sensible al eje.

Usando una escala de 4:1, el dngulo medido por el potenciémetro esta dado por § = 4«, por lo
cual el rango de giro de la base esta dado por:

wp-Gga
B_ K
“5=6o4 =31

El giro que la base realiza es obtenido integrando la velocidad medida.
&= [ @ ot

3.3 Parametros

Algunos de los parametros del SRV-02 son:

e Velocidad de Giro:

El motor es uno de DC de 12V, cuya ecuacion esta dada por:
Vgm = IgmRgm — Kgpwyg

Donde el circuito ideal tiene corriente igual a cero, pero en este caso la friccién produce una
pequefia corriente en direccidon del motor. Para el espacio de estados tendremos que la velocidad
angular sera:

0. = I{qm - Inggm

g Kgb
Donde:

Vym = 12 Volts DC

Rym = 530

%4
K, =0.0235———
gb rad/s

Considerando que no hay friccion tenemos que la velocidad del disco sera:

V, rad
< =510 (—)
g S
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Una mejor estimacién es obtenida midiendo la corriente utilizando un amperimetro, obteniendo
una corriente de 0.23 amperes resultando una velocidad:

51Orad
Wy= e
9= s
* Momento de giro:
La inercia del disco esta dada por:
2
T
f
=M, =
Jr =M~

2 x 0.254)2
0.g 2 X 02587

Jr= >

= 1.0323e 3K gm?
Asi el momento sera:

hg = 457 X 1.0323e73

Kgm?
hy0.4718 9™/

* Rigidez comun

Los dos resortes se encuentran de la siguiente manera:

F2

T I

1 Le

1]

4

——>
——>

Lz

—
—

-
o
o
o

;

Figura 11 Modelo de puntos de rigidez

La rigidez al eje de rotacidn es interpretada de la siguiente manera:
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Asumiendo que los coeficientes de los resortes son constantes Ks y una elongacién de L, la
elongacidn de los resortes en condiciones normales (a=0) estara dada por L. suponiendo que el eje
esta girado una distancia a, entonces las 2 fuerzas estaran dadas por:

F, = K,6L,
F, = K.6(L — L, — Rag)
F, = K,6L,
F, = K,8(L — Ly, + Ray)

Entonces la fuerza de giro generado por las fuerzas sera:

T =R(F1—F;)
T = 2R?K,a

Entonces la rigidez rotacional estara dada por:

K—T
9«
K, = 2R2K,

Ky, = 2(0.0254)%(1.9089¢2)

Ky = 24631N —m/rad

e Sensibilidad de giro

La sensibilidad del giro con respecto al eje (a), sera:

24631 [ /5]
97 04718]| °

G, = 5.2205
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Y la sensibilidad con respecto al potenciometro (B) esta dada por:

-af

4

G = 1.3051 [ﬁ]

e Diseno del sistema de control

Suponiendo que la placa del soporte (y el servo) giran con respecto a la base, el angulo Y y el
madulo de giro, giran con relacién al médulo servo con el dangulo 6. El giro total del médulo del
giréscopo con relacion a la base esta dado por:

E=y+6

Queremos disefar un controlador que mantenga ¢ en cero grados independientemente de Y y que
solo podemos utilizar la medida de B del sensor de giro.

Derivando la ecuacién anterior y reescribiéndola tenemos que:

Suponiendo que la placa del soporte (y el servo) giran con respecto a la base, el angulo Y y el
modulo de giro giran con relacién al modulo servo con el angulo 6. El giro total del modulo del
giréscopo con relacion a la base esta dado por:

E=y+6
$ = wp
B
wp = ng
Resultando:
4 .
B = G—(V +8)
g
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Por lo cual se requiere controlar que la integral de B sea cero.

Las ecuaciones del servo motor (SRV-02) son:

VizlIm R + Ky Ky 0 =1y Ry + 5Ky K 6

Tm=Im Km Kg =] 0 =];5%6

Resolviendo para 0 se tiene que:

%4
0 =% =
mJt .2 _
Ko K, s —Kn Ky s
Substituyendo en la ecuacion de B se tiene que:
4 Vs
B = G_ SZV + R ] UL
mJt 2 _
9 Ko K, s —Kn Ky s
4
4 G—ngs
b=V R s
9 Ko K, s —Kn Ky s
Definiendo una nueva variable:
_B
& =—
S
Se obtiene:
4
4 G, m
£ sy
G R Jt 5 _
9 Ko K, S Knm Ky s

Disefiando un controlador para que € se mantenga en cero, se define al controlador, como:
CONTROL EN TIEMPO REAL DE UN GIROSCOPO
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Vin = kpe + kgse
Obteniendo la funcion de transferencia:

£ .52 +nys

Y  S382 4515+ s,

Donde:

ny = 4Ry
ng = —4K,%K;
S2 = Gg]tRm

51 = —GyKZKZ — 4Ky K Ky

S0 = —4K Ky K,

Ndtese que el espacio de estados, la ganancia de la funcién de transferencia es cero, para un
escaldon eny, g, tiende a cero, esto significa que (y + 8) tiende a cero. Esto quiere decir que O gira
en la direccion de (-y), que es exactamente el efecto deseado.

Ahora seleccionando un factor de relacion (Z) de 0.707 y una frecuencia natural de 5Hz(es decir se
limitan las perturbaciones a 5Hz) se obtiene la funcion de transferencia deseada:

s+ 2wys + wl

Ahora resolviendo para las ganancias de retroalimentacién tenemos que:

K, = —6237VI/rad

(2zwq JeRm + K5 KZ)

Ky = —1/4G, T
mig
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Ky = 2.9159VI(rad/sec)

Convirtiendo a grados tenemos que:

K, = —1.0VI°

K; = —0.5VI(°/sec)

El diagrama de control se muestra a continuacion:

|

Perturbacién

4

+ Vim e
Kp _'O - servo - Gyro
] Plataforma
Estabilizada

sensor

Plataforma libre

Reset

Figural2: Diagrama de control.

Direccién sefialada

(no medida)
+

po)

Inclinacién del girescopo
(medida en el sensor)

La perturbacion del giro representa una perturbacion externa aplicada al soporte de la base (por

ejemplo nosotros) asi el servo motor gira alrededor de un punto pivote en la base de la plataforma

en un anguloy. Esta rotacion ocasiona la inclinacién de a en el eje sensible proporcional a la

velocidad cambio de y.la inclinacién a es medida por el sensor que tiene una ganancia de

4(relacidon de cambio)y el control de retroalimentacion es el angulo B.

B es integrada para obtener a €. Nétese que € no es derivada para obtener el termino (kgs€) en el

lazo de retroalimentacion. En lugar de esto B, es usada directamente esto, no necesariamente

introducira ruido. El voltaje V., aplicado al servo resulta en un giro del modulo del giréscopo con

relacidn al servo alrededor de 8 que es compensado pory y regresa a € a cero.

CONTROL EN TIEMPO REAL DE UN GIROSCOPO
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4. Programacion de la solucién en LABVIEW

4.1 Controlador PD.

Un controlador que funciona tipicamente como un amplificador con una ganancia constante k se
conoce formalmente como control proporcional, ya que la sefial de control a la salida del
controlador esta relacionada con la entrada del controlador mediante una constante proporcional.
El controlador de tipo Proporcional derivativo presenta la siguiente funcién de transferencia:

G(s) = K, + Kps
4.11 Métodos de sintonizacion

Los controladores actuales son dispositivos de aplicacién general, cuya adaptacion a un lazo en
particular se realiza mediante la sintonizacion. El caso mas general, es el controlador que actua
con las tres acciones: proporcional, integral y derivativa.

La sintonizacidn consiste en asignar valores a las constantes K., T;, y Ty de forma que el lazo de
control responda adecuadamente a las perturbaciones externas. Un controlador se puede
considerar sintonizado, cuando un cambio en el punto de consigna o en las condiciones del
sistema de lazo cerrado, produce como maximo 3 o 4 oscilaciones de la variable alrededor del
punto de consigna.

Para la sintonizacién de los controladores existen diversos procedimientos, pero la sintonizacion
finalmente se realiza de forma experimental, siendo muy importante la experiencia del operador
que lo lleva a cabo. Una forma alternativa es mediante la técnica de contornos de las raices, que es
la misma del Lugar Geométrico de las Raices pero con variacion multiple de parametros.

Por otra parte, existen algunos procedimientos estandar, que estan basados en criterios para
minimizar la funcion de error de varias maneras. Es necesario mencionar que los resultados que se
obtienen al aplicar estos procedimientos, sélo dan una indicacion de los pardmetros iniciales
(base) y a partir de éstos, es necesario hacer un reajuste de los mismos para obtener la respuesta
de lazo cerrado deseada.

Por el momento solo se presentan dos de los métodos mas empleados: oscilaciones amortiguadas
(Harriot 1957) y la curva de reaccion (Ziegler-Nichols 1942)

4.12. Método de oscilaciones amortiguadas (Harriot 1957)

Consiste en operar el sistema en lazo cerrado con una accién proporcional, empleando la
configuracion de la figura
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k - Gis) —=
SEMAL DE
CONTROL

¥t

Figural3: Lazo cerrado.

Donde:

r (t) eslasefal de referencia, punto de ajuste (Set point) o punto de consigna.
e (t) es la sefial de error

u (t) es la sefial de salida del controlador o sefal de control

d (t) es la sefial de perturbacion

y (t) es la sefial de salida (variable controlada)

Aplicando en cada prueba una variacion de referencia de tipo escaldn, la ganancia del controlador
proporcional se ajusta hasta que la respuesta del sistema realimentado tiene la forma de la figura

wt)

Figurald: Respuesta del sistema realimentado.

La relacion entre el primer y segundo sobrepasos debe ser igual a 0.25, esto es:
b
—=0.25
a

Esta condicién se logra cuando el factor de amortiguamiento relativo de los polos dominantes es
de 0.2176. En este caso, el proceso queda caracterizado en su dindmica, con los parametros:
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Ko: es el valor de K. para el cual la respuesta escalén del sistema realimentado presenta una

relacién entre el segundo y primer sobrepasos de 0.25.

To: es el periodo de oscilacion de la respuesta a escalon del sistema realimentado para las
condiciones especificadas.

Las férmulas de sintonizacion en este método son:

Tabla 1.Férmulas de Sintonizacion

Tipo de controlador K. T; Ty
P K, - _
PI K, T, -
PID Ko T, 0
1.5 6

4.13 Método de la curva de reaccion (Ziegler-Nichols 1942)

En este método de sintonizacién se determinan las caracteristicas dindamicas del proceso a
controlar, a partir de la respuesta del sistema en lazo abierto. Una vez que se tienen estas
caracteristicas es posible obtener los parametros del controlador. La caracterizacidn del proceso
es como sigue: la planta en lazo abierto es excitada con una funcidn escaldn y se obtiene su
respuesta, teniéndose en este caso una curva como se muestra en la figura.
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Punto de Inflexion

Tm

[ 8.2 B4 86 Y]

Figura 15: Respuesta escaldn.

En esta curva se determina el punto de inflexién y sobre él se traza una recta tangente a la curva.
Esta recta intersecta al eje de tiempo y el tiempo muerto que caracteriza al proceso se mide desde
el origen hasta este punto de interseccidén, como se muestra en la figura. El otro parametro que se
requiere para la sintonizacion es la pendiente de la recta tangente en la respuesta graficada.

Las formulas de sintonizacién estan en la siguiente tabla:

Tabla 2. Parametros de Sintonizacion.

Tipo de controlador K. T; Ty
P 1 - -
RT
Pl 0.9 T, -
RT 0.2
PID 1.2 T, 0.87
RT 0.3

Tn: es el periodo de oscilacion de la respuesta a escalén del sistema realimentado para las

condiciones especificadas.

CONTROL EN TIEMPO REAL DE UN GIROSCOPO
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4.2 PROGRAMACION DEL CONTROLADOR (PD) EN LABVIEWRUN-TIME 7.1

La rutina de control para la ejecucién en tiempo real se programo en esta version de LabVIEW,
debido a que los controladores de la tarjeta de tiempo real PCI7041/6040E solo se emitieron hasta

la versién de LabVIEW=-RUN-TIME7.1 debido a que el modelo fue descontinuado por el fabricante

National Instruments.

A continuacidon se muestra el cédigo realizado para llevar a cabo el proceso de control antes
mencionado:
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Figura 16. Programa final de un control PD en LABVIEW RUN-TIME 7.1
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4.21 Ciclo While con temporizador

El programa principal esta contenido en un ciclo while, en el cual es configurado el tiempo en que
se desea trabajar, como se muestra en la siguiente figura:

Finished Lake [i-1]

Figura 17. Configuracion del ciclo while.

Las configuraciones importantes por realizar son:

|EnliRHz ] . Configura el reloj de la tarjeta.

| dt I Configura el tiempo de ejecucién(en este caso 1ms)

Trabaja en
tiempo real?

Finished Late [i-1] |- #TE]|

Esta parte del programa verifica que el mismo este
ejecutandose en el tiempo de ejecucidn dado, en este caso es de 1ms, de no ser asi una luz roja se
encendera en el panel frontal del programa.

4.22 Proceso de adquisicion de lectura del encoder(Digital)

 Dov1portofinen:7 [7] g ] s
[ore charnel For al e 7] - o Eresss]
s Hiss
Digital Input 7| Digital 10 Bool ) {cH Az>e]
1Chan 15amp E

Figura 18. Proceso de adquisicion de datos del encoder

En esta parte el puerto digital es configurado para obtener la lectura de los pulsos del encoder del
giréscopo y se realiza la creacién del canal virtual.
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|5 DevijpartOfline0:7 |»f-fi >
lore channel For allines *jH ™ = {5

JLL|

Digital Input *

Figura 19. Creacidn del canal virtual

Al mismo tiempo se lleva a cabo la lectura de dichos pulsos, a través del puerto digital de la tarjeta
BNC 2120 de National Instruments. También se separan los canales A y B en este caso en un
arreglo donde usamos el canal o como canal Ay el canal 1 como canal B.

mt O 3
1H=: o

Digital 10 Bool
1Chan 15amp

Figura 20. Lectura del canal digital

Se realiza un monitoreo visual de cdmo se comportan los canales digitales en el panel frontal a
través de un indicador booleano.

A la salida del ciclo detenemos el proceso y limpiamos el canal virtual creado.

Figura 21. Paro de lecturas y limpia de canal virtual

Después de haber obtenido los pulsos de los canales A y B procedemos a realizar la conversion de
dichos pulsos a unidades de grados.

4.23 Rutina de conversion de lectura del Encoder a posicion angular

| |proceso 2 E[Eh_a,(fﬂ
Tluer | 1 [ E> HEL]]
13051 l_f,@

Il

Figura 22. Rutina de conversion de pulsos a cuentas y grados.
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Se lleva a cabo la retroalimentacion de las lecturas a través del registro de corrimiento. La cual nos

permite leer el estado actual del sistema.

Figura 23: Registro de corrimiento.

En esta seccidn se lleva a cabo la deteccidn del nimero de cuentas (pulsos) y el sentido en el que
esta girando el mddulo.

Figura 25. Lectura del estado actual y estado siguiente de los canales Ay B

En esta seccién del programa, se discriminan las lecturas a solo el paso de una sefal con las
compuertas XOR programadas, ya sea la sefial actual del canal A o B (A’ o B’) o la del estado
siguiente (A o B), para asegurar que la cuenta (pulso) no tenga error de traslape, entre el estado
actual y el estado siguiente(se previene que Ay A’ o B y B’ no ocurran al mismo tiempo)
finalmente una compuerta OR es la que nos entrega el valor alto, para poder proseguir a realizar la
cuenta de pulsos.(El estado Actual lo obtenemos a través de la retroalimentacién)

Figura 26. Determinacion del sentido de giro.

En esta seccidn se lleva a cabo la deteccidn del sentido en el que gira el modulo, se obtiene a
través de una suma o resta de cuentas (pulsos) los cuales nos entregaran ya se a un signo positivo
0 negativo segun sea su caso, esto quiere decir que en caso de que el estado siguiente del canal B
y el estado actual del canal A (A’) ocurran al mismo tiempo tendremos una cuenta con signo
negativo, esto quiere decir que el canal A va en direccién del B, esto indica un cambio en el sentido
del giro. Mientras esto no ocurra se tiene que el valor de la cuenta sera positivo, lo cual indica un
giro en sentido positivo.
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Figura 26. Generacién de las cuentas. Figura 27. Deteccién de cuentas.

En esta parte del programa se lleva a cabo la g
retroalimentacion, es decir al estado actual de la cuenta,

eneracion de cuentas, utilizando una
se le sumara o restara una cuenta, segun

sea el caso, de acuerdo con el resultado obtenido en la parte anterior del proceso, es decir la
determinacién del signo de la cuenta, esta seccidn funciona como un contador (con incremento o

decremento de una unidad), a estado actual se le suma el

estado siguiente.

Figura 28. Reinicio de cuentas

El programa consta de un reinicio en la posicidon, es decir, se puede reiniciar el numero de cuentas

gue se han producido hasta el momento, mandando un valor de cero al valor de las cuentas.
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Figura 29 Conversion de cuentas a grados.

En esta seccidn, se lleva cabo una conversidon de cuentas a grados, la cual nos permite, llevar a

cabo el proceso de control, en la primer parte el nume
equivale a los grados que lleva una vuelta, y se dividen

ro de cuentas se multiplica por 360, que
entre los 4096 cuentas que equivalen a

tener una vuelta (4096[cuentas]=1[RPM]). En la siguiente partes toma en cuenta la sensibilidad del
aparato, es decir el valor de lectura que tenemos no es absoluto debido a la sensibilidad del giro,
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por tanto se divide entre 1.3051 (sensibilidad de B), que es la sensibilidad del encoder para

corregir la medicion de los grados.

Figura 30. Despliegue de datos

En esta seccidon se lleva a cabo el despliegue de datos leidos en la pantalla frontal, la primer
lectura, se obtiene directamente del encoder inferior (Encoder del srv-02) es la de beta (B), a partir
de esta medicidn se puede conocer el valor de la variable alpha (a) gracias a la relacion ya antes

mencionada.

4.24 RUTINA DE CONTROL (PD)

.
b Fm,
. _ [ . Reeplace Array Subset
(1,3
:
] f.ot | l> """"" B8 ==
[l .. T g I>* il
II | | [variatle
e
proceso
)

Figura 31. Control PD

El proceso de control es realizado con respecto a la variable B.

Para este tipo de sistemas, se tiene una variacidn considerable en la variable de proceso, es por
eso que en la retroalimentacion se lleva a cabo la integracion de la misma, lo cual nos permite

tener un mejor desempefio de control en este tipo de situaciones.
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Figura 32. Integrador. Obtencidn de épsilon (g)

En esta parte se lleva a cabo el proceso de integracién de la variable de proceso, multiplicando por
la diferencial de tiempo, que en este caso corresponde al valor de 1ms(0.001s), y se lleva a cabo la
retroalimentacion de la misma, a la salida de este proceso obtenemos una nueva variable llamada

épsilon(g).

Farametros e [ 1>

D I e~ [

|Bet:a=EpsiI|_‘|n Punto]

Figura 33. Control PD

La variable leida directamente del encoder se le nombrara ahora épsilon punto, para poder llevar
a cabo la parte proporcional derivativa, es decir, que beta, sera la velocidad con la que gira la base,
en esta parte del proceso se lleva a cabo el control PD (proporcional derivativo), en este se
multiplica el pardmetro de proporcionalidad y de derivacién., finalmente las dos sefales se suman
a la salida. Siendo esta nuestra variable de control.

Meqgate
I> e . b
eauv] L]
}
5.5 %%% R =

Figura 34. Salida del control.
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La salida de control es negada, debido a que el giro de a que esta relacionado con B es negativa (-
H), después de esto la sefial pasa por un saturador, para evitar que la sefial de control sobrepase
los +10 (V) o los -10(V)(este voltaje es contemplado en el modulo UPM), ya que esto puede dafiar
el aparato, en esta secciéon se obtiene la sefial de control, saturada, después esta sefial es
nombrada sefiala saturada, después esta sefal contempla la ganancia que tiene el cable con el
enviamos la sefial de la tarjeta al modulo UPM(valor de -1),

Figura 35. Modulo UPM

.'b' I

|
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Figura 36. Envio de datos al motor.

Una vez finalizado el proceso de control, se envian los datos a un arreglo, que esta inicializado en
cero, después este arreglo comenzara a variar de acuerdo a la variable de control, este proceso se
retroalimenta para poder mantener la sefial de control, debido a que como anteriormente se
habia mencionado, este es un sistema con el cual la variable del proceso cambia en cada instante,
y no da tiempo para lograr una estabilizacidn del sistema, sin embargo con esta retroalimentacion
se logra mantener estable la sefial de control.

4.25 Rutina para el envio de la seial de control a los motores del SRV02

Inicializacidn del canal analégico (para enviar los datos al motor)
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Figura 37 Creacidn del canal virtual analdgico de salida.

En esta seccidn se crea el canal de salida anagdgico, en la primera parte, determinamos el canal
que enviara la sefial (Dev/1/a0), el voltaje maximo (+9[V]) y el voltaje minimo (-9 [V]) unidades de
salida (Volts[V]) y finalmente el tipo de voltaje de salida (RSE).todo esto en un cluster, el cual
después se separa por variable y se conecta a la funcion de creacidn de canal virtual.

Analog 10 DEL _
1Chan NSamp

bl Totatus |-

Figura 38. Envio de datos analdgicos en multiples muestras al motor.

El envio de datos obtenidos del control hacia el motor se lleva a cabo por medio de un canal
digital, en la parte de estado(status) se verifica que no exista algin problema durante la escritura
en el motor, de ser asi envia una sefial de paro de programa.
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Analog DBL
1Chan 15amp

Figura 39. Detencion del canal analdgico limpiado del mismo.

El motor se detiene una vez que se envia un voltaje de O[V] al mismo, después se procede a
detener el canal analdgico ya la limpieza del mismo.
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Figura 40. Seccion para Detener el Programa.

El paro del programa se realiza mediante el botén de paro en el mend, o debido a alguna falla

durante la lectura y escritura de datos.

el

Figura 41. Salida de error

Estas funciones sirven para desplegar, si es que existiese algln error por el cual se halla detenido

el programa.

@15@ B o

Lk )81

Figura 42. Despliegue de datos en el panel frontal (V (m))

En esta seccidn se analiza el comportamiento de la variable de control, que en este caso es V (m),
y se hace un despliegue en un indicador numérico y uno grafico.

4.26 Rutina del proceso de adquisicion del Tacometro

Inicializacidn del canal analégico (para enviar los datos al motor).
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Figura 43. Creacion de un canal virtual analégico de entrada.

CONTROL EN TIEMPO REAL DE UN GIROSCOPO Pagina 27



100

Esta seccidn corresponde a los parametros de configuracién de entrada, tales como valor maximo
de entrada como valor minimo (+-9V para este caso), también se configura el tipo de unidades que
se manejaran (en este caso es voltaje), también se configura el tipo de voltaje que se manejara (en
este caso es con referencia a una tierra), también se define el canal de entrada de la tarjeta que se
tiene (en este caso el canal 1). Lo cual se incluye en un cluster, el cual se separara por nombre de
cada una de las variables .y el cual se conectara a las entradas del canal virtual creado y

configurado como entrada.

Una vez terminado el proceso de creacién del canal virtual, se procede a obtener las lecturas de la
tarjeta, lo cual se lleva a cabo con la funcién de lectura la cual se configura como un canal de
entrada y una muestra.

De aqui se obtiene un voltaje, el cual se compara con el voltaje que se envia al motor, para
verificar que el control realizado, funciona adecuadamente.

iarafica de
alkajes

k20E |
[racometra[v]]

& FIBL ||

Figura 44. Graficas de voltajes.

Una vez terminada la lectura, se utilizan los datos para llevar a cabo la interpolacion de la lectura
de voltaje obtenida en el canal 1, proveniente del tacémetro del srv02 y transformarla a velocidad
angular, a través del modelo matematico y = 46.75x — 0.556 el cual se obtuvo a través de una

serie de muestras.

la6.751 I> _
L m|:|555 ik L .p":.::u_ |

e

(T acommetraly

4—TWoBL
Figura 45: Transformacidn de voltaje a velocidad

Programacion del tacémetro
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IDr(es el valor absoluto del valor de giro).

> .
acamekro

. Despliega la velocidad de giro de la base en el panel frontal.

Al final de este programa obtenemos la velocidad angular a la que la base del girdscopo se
encuentra girando, esto es muy importante para nosotros, ya que por medio del tacometro
podemos calcular la posicién final que posee el girdscopo, es decir la posicion de a, de la siguiente
manera:

Poscicion Final[®

~RIEL |
Booi— %>
Figura 46. Obtencién de la posicion angular final de a a través del Tacdmetro.

Dicho célculo se lleva a cabo de la multiplicacién de la posicidén angular por el tiempo en el que
estamos trabajando, en este caso es 1ms.

Una vez obtenida la posicidn, esta se grafica al mismo tiempo que se grafica la posicidén de alpha,
para verificar que realmente se estda manteniendo en la posicion deseada.

Euscicihn Final[? Iarafica de

FOEL Fosciciones

k0 |

Figura 47: Realizacion de las graficas de posicién final.

(Tacometro y alpha (obtenida del encoder)).

4.27 Mesurement & Automation Explorer

Antes de comenzar a ejecutar el programa es necesario verificar la conexion con la tarjeta
PCI7041/6040E de National Instruments a través del Mesurement & Automation Explorer
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View Tools Help

Configuration

{8 Data Nsighborhood
@ Devices and Interfaces
(@ NI-DAQmx Devices
X1 P System (Unidentified)
- Ports (Serial & Paralel)
B rrio A
(8 Data Neighborhood
= @ Devices and Interfaces
= {3 NE-DAQMX Devices
1 60408 "Devt”
Seales
1 @9 Software
1 @ Historical Data
3 Scales %
« @ software
« @) WIDrivers
o €38 Remake Systems

Después se selecciona la parte de NI Devices and Interfaces seguida de la seccién de
después presionamos el boton “selftest” y finalizamos la revision de conectividad.

Category Help

National Instruments
Measurement & Automation Explorer

What is Measurement & Automation Explorer?

Measurement & Automation Explorer (MAX) pravides access to your National Instruments GAN, DAQ, FieldPoint,

GPIB, IMAQ, IV, Modular Instruments, Motion, NI Switch Executive, VI Logger, VISA, and vxI devices. With MAX,

you can:

Configure your National Instruments hardware and software

Create and edit channels, tasks, interfaces, scales, and virtual instruments
* Execute system diagnostics

View devices and instruments connected to your system

Update your National Instruments software

What do you want to do?

Note Some categories are device-specific, For example, the IvI category appears only if you have Iv1
installed.

= Configure my devices and interfaces
Select Devices and Interfaces in the configuration tree to the Ieft. If you need help installing your device,
refer to the getting started information included with your National Instruments hardware

view, launch, and update my installed National Instruments software
Select Software in the configuration tree to the left

= Create virtual channels or tasks for my devices
Select Data Neighborhood in the configuration tree to the left,

= Create and configure scales for my virtual instruments
Select Scales in the configuration tree to the left.

Configure my IVI instrument drivers
Select VL in the configuration tree ta the left

Import/export my device configuration file.
Select the File»Impart or File»Export menu item to import or expart

AX Help

Max displays interactive embedded help in the
right side of the MAX windaw to guide you
through configuration and basic tasks.

% To learn about any task an the list, click on it.
click here for dixample

% Some task lists include interactive buttons. For
example, to save a channel eanfiguration to a

file, click

rom the task list.

# For more infarmation, selest available help
categories from the Help »Help Topies menu

If you need further assistanee or want to know
more about your device, visit the National
Instruments Technical SupSEEE Web site,

nfigural

not supported. Please see your product-specific documentation

Lin dispasitiva USE de alta velacidad esté conectad dentro de L concentradar USE
de alta velacidad.

Faga
prablema.

este

Figura 48. Pantalla inicio de “Mesurement & Automation Explorer”
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) (8 MI-DAQMX Devices s Numbe %
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1% Ports (Seria & Paralle) vemory Range 2 0xC0001000 - (XCOODIFFF Basics
= B0 RO Level oxa
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¥ 6040E: Devt”
i+ (@8 Scales
4 @ Softwere
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1 @ Softwere

1 @ V1 rivers

4 Remate ystes

Success

The device has passed the selftest.

What do you want
to do?

< Bunthe Ni
DA Test Panels
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device

* Vieworchange
device properties

L) tibuies | 8 Device Routes | 4] Caibration

Dibu

Figura 49. “Mesurement & Automation Explorer”
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4.28 Descripcion del panel Frontal.

Después de esto se procede a comenzar con la descarga del programa a la tarjeta de tiempo real.

£ pid250610.vi Front Panel
Filz  Edit Ope Tools Browse Window Help

e o |

B! Downloading. ..

WIs Downloaded
¢ oEm DAQMsx Creats Channel (DI-Digital INput). vi (6.45 K)
E@0.0213 DAQmx Creats AC Channel (sub).vi
DAQmx Create Channel (AO-Voltage-Basic).vi (12.03 K)
ask.vi (7.32 K
2

o705 |

TIONAL _TNSTRUMENTS hvalarm.ctl (1.06 k)

Download Progress

Free Memory: 20872 K of 65150 K Tokal (32%)

[ lPata kit tinloct Famplotes

oo |

£ e

Figura 51. Panel frontal del programa de control. (Programa funcionando)
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Figura 52. Pardmetros de control.

Controles numéricos para cambiar los parametros del control K_p y K_d.

Figura 53. Tacémetro.

Despliegue de la velocidad medida en un indicador analdgico y digital.

Figura 54. Alarma de funcionamiento del programa en tiempo real.

Figura 55. Boton para detener la ejecucion del programa.

Figura 56. Boton para reiniciar el nimero de cuentas, utilizado durante el proceso de pruebas para corregir posiciones
mal medidas, debidas a diferentes circunstancias.
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Figura 57. Despliegue de las graficas de posiciones Finales, con sus indicadores digitales en la parte de la grafica.
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Figura 58. Despliegue de las graficas de voltajes tanto del motor como del tacdmetro con indicadores digitales.

4.3 PROGRAMACION DEL CONTROLADOR (PD) EN LABVIEW 8.6

Se ocupa esta version de LabVIEW, ya que es una plataforma que cuenta con los controladores de la tarjeta
PCI6024E, la cual trabaja a una con el tiempo de ejecucién de Windows (no tiempo real) se realiza la
programacién en la versién 8.6 de LabVIEW, la cual se muestra a continuacion:

agr 11 TN sk it M g ke

Figura 59. Pantalla de inicio de LabVIEW 8.6
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Figura 60.Programa de control PD en LabVIEW 8.6
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Se observa que la programacién es muy similar a la de labviewrun-time7.1 lo Unico diferente es ciclo while,

ya que en este no se puede tener un tiempo de muestreo deseado, este ciclo while trabaja a un tiempo de
24ms (que es el tiempo de ejecucién de Windows).

B! finalok.vi
File Edit View Project Operate Tools ‘Window Help
[ [@[n] o
A
CONTROL EM TIEMPO REAL DE
UN GIROSCOPO
LABVIEWS.6
(SIN TARJET A DETIEMPO REAL)
Tacometro
T
o= ll”” . PARO GENERAL
-200 200
~-300 200
-400 400 Kp
7500 s00 v p
4 i Re\nicwar_posicion f)lrU'UZS
1.1825 - :,.m'::
Yaltaje de Matar ] Poscicion Final m
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Figura 61. Panel frontal del control PD en LabVIEW 8.6

El panel frontal es similar visto anteriormente en LabVIEWRUNTIME7.1. El proceso para la
verificacion de la tarjeta PCI6024E se lleva a cabo de manera similar que en labVIEWRUNTIME7.1.

4.4 Desempeiio en el Tiempo del Controlador en Tiempo Real

Para medir el desempefio del programa en el tiempo, fue necesario agregar los bloques TraceTool
Start Trace VI y TraceTool Stop Trace and Send VI del LabVIEW Execution Trace Tool. Se muestra
en la Figura la adicién de dichos bloques, a fin de recabar los datos a ser vistos después en la
sesidn dentro del LabVIEW Trace Tool.
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programa de control
pd

Figura 62. Rutina para la medicién de desempefio del programa.

Con la inclusidn de las funciones del Execution Trace Toolkit podemos verificar el tiempo de
ejecucion real de cualquier ciclo dentro del programa, en este caso nuestro proceso de control
Ilamado PD, en la figura verificamos que el ciclo de control tarda en ejecutarse 1 [ms] en
promedio.

# Real-Time Execution Trace Toolkit

Fle Wiew Help

2@ 127001

Highliht CPL Mode: slectin; | | G1E 2T
tej0af2010 11:46; Ighight CPU Mode laton: | | S 2E B

: T 1 Herramientas de
QL TO0LR Analisamos La ejecucién del Programa de UL L]

1 75 Time Thread Wﬂm 1| tiempo de wedilén

2 Unnamed Thread el 1o cjvzczcuc ion de

3 Command Server LIDP Socket Threa ] 925.0491[us]

4t Cornmand Server TCP Socket Threa | I

5 £75 Nl Thead | .‘_
6 Unnamed Thread il

7: Unnamed Thread U L)

&: Unnamed Thread

9 Main Application Thread

10t Urnamed Thread

10 Urnamed Thread

12t Urnamed Thread

13: TimeoutManager

14: LabWIEW Thread [User Inkerface]
15: Lnnamed Thread

A Puentien Ve e Thae ]

0 DAQm:: Write (Analog 10 DEL 1Chan Naamy 0O

11 pideonkacttk.yi [ ] 00 I

2 DAQmx Read (Analog DEL {Chan 15amp).v: [}

5 DAQmx Read (Digtal L0 Bool 1Chan 13amp: O
< DAQM: Stop Task.vi

5 DAQM:: Clear Task.vi

6 Merge Errars.vi

7: TraceTool Stap Trace And Send vi

& Gek Texk Rect.vi

9, timing.ctl

10: MlarmRef_NATIONAL_INSTRUMENTS Jva
11: Convert property node Font to graphics fol
12: eventvkey ol

13¢ Clear Errors.vi

14 whitespace.ctf ¥

Figura 63. Execution Trace Toolkit para el ciclo de control en la tarjeta NI PCI-6024E.
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